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Lab 1: Knife-Edge Scraper for Beam Profile and Halo Measurement

1.1 Aims and Objectives

This experiment aims to demonstrate the principle of
a particle beam scraper for fast measurement of trans-
verse beam parameters, by making an analogous trans-
verse profile measurements of a laser beam with a
knife-edge scanner. The measurement of a transverse
beam profile is important for several methods to deter-
mine the emittance, namely the three-screen method,
the quadrupole scan, and the pepperpot technique,
which are explored further in the other laboratory ex-
periments. The knife-edge scanner is also useful for
beam halo measurement. The main objectives are:

• To set up the optics equipment to measure the
transverse beam profile of a laser beam.

• To autonomously translate a knife-edge across a
laser beam and record the transmitted intensity at
a photodiode.

• To analyze the data by filtering, then differentiat-
ing the photodiode signal to generate the measured
beam profile and determine the laser beam width
via a Gaussian fit.

• To appreciate the dynamic range necessary to
measure beam halo distributions, through mea-
surements of the Fraunhofer diffraction pattern
from a single slit.

1.2 Beam Profile Measurement Theory

Scanning a knife-edge across a particle beam allows the
transverse beam profile to be measured from the differ-
ential of the transmitted intensity. See for example: J.
A. Arnaud et al, Technique for Fast Measurement of
Gaussian Laser Beam Parameters.

1.2.1 Beam Halo

The core profile of a particle beam may be measured
using for example, a wire scanner that records the cur-
rent resulting from secondary emission due to impact-
ing particles. In addition, however, a particle beam nor-
mally has a halo distribution, which arises from vari-
ous processes including: beam gas elastic and inelastic
scattering, incoherent and coherent synchrotron radia-
tion, scattering off thermal photons, intrabeam and Tou-
schek scattering and ion or electron-cloud effects; beam

optics, and collective effects. In synchrotrons, the beam
halo is an important background source for the experi-
mental detectors, and is also critical for radiation sensi-
tive components in the accelerator. Beam losses at the
level of < 0.1% lost particles per bunch can be harmful,
therefore we require a beam monitor capable of mea-
suring the transverse beam halo better than this. The
required dynamic range is therefore of the order of 105

or better. To achieve this dynamic range, a combination
of wirescanners and knife-edge scrapers is sometimes
necessary to capture profile data from the intense core
and the halo distributions respectively.

1.3 Experimental Setup

The equipment is in the dark room in section-C (far cor-
ner) of the RHUL Tolansky teaching laboratory.

Warning: the He-Ne laser in this experiment is a
class IIIa laser. Avoid direct eye exposure to laser
radiation. Do not stare into the beam and remove
any reflective jewellery before operating the laser.
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4. Laser safety and lab requirements 
Warning: the He-Ne laser in this kit is a class IIIa laser. Avoid direct eye 
exposure to the laser beam! 
 

Follow the corresponding laser safety guidelines based on AS/NZS 
2211.1:1997 and other lab instructions about optical components etc. 
 
 
Appendix: User Instructions of Silver Salt Plates 
Silver salt plate is a common holographic recording medium with high sensitivity, broad spectral 
response range, and wide adaptability. The micro particles of a silver salt plate make it suitable for 
recording a variety of holograms. The drawbacks of silver salt plates are low diffraction efficiency 
and low signal-to-noise ratio, together with tedious post-exposure processing procedures.  

1. Specifications: 
Wavelength: 632.8 nm 
Contrast Ratio: >4 
Sensitivity: >30 J/cm2 
Thickness: ~ 7 m 
Resolution: >3000 line pairs/mm 
Size: 90!240 mm 
Storage: > 1 yr under low temperature environment of 0 C to 7 C such as in a refrigerator 
Safety Lamp: Dark green lamp in a darkroom 

2. Handling and Processing Procedures 
1) Cutting of an unexposed silver salt plate 

Before cutting a silver salt plate, place the container under room temperature for about 4 hours 
and then open the container in a darkroom under the aid of a dark green safety lamp. Put the 
film side of a silver salt plate down onto two plastic sticks and then cut the glass substrate side 
from the top with a glass cutting knife into desired sizes. Knock the silver salt plate near the 
cutting trace on the substrate side gently with the handle of the glass cutting knife and then 
break the plate into two pieces with fingers. Wrap unused silver salt plates up with the black 
paper and put back to the container.     

 

2) Exposure of a silver salt plate 

The typical size of micro particles with a silver salt plate is in the range of 0.03 to 0.09 
smaller size of micro particles the lower photo sensitivity and higher resolution. For this reason, 
the exposure time of silver salt plate is longer than that in conventional photography. In 
addition, the exposure time of a silver salt plate depends on factors such as the laser power and 
the reflectivity of an object. In practice, one had better use a small stripe of silver salt plate and 
expose different locations of the stripe with different exposure time durations to determine an 
optimal exposure time after post-exposure processes. 

Note:  Wear gloves during this process to avoid finger print on silver salt plates.   

DANGER
LASER RADIATION

AVOID DIRECT EYE EXPOSURE

HELIUM-NEON LASER
1.5mW MAX OUTPUT at 632.8nm

CLASS IIIa LASER PRODUCT

30

20

A HeNe λ = 632.8 nm laser is aligned on an optical
rail such that light passes through a series of focusing
lenses to converge on distant photodiode, as shown in
Fig 1.1.

Figure 1.1: Overview of setup for knife-edge laser
beam scraper
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The photodiode signal is recorded via an National In-
struments MyDAQ data acquisition card, as in Fig 1.2,
connected to a laptop computer. The laptop also con-
trols a New Focus pico-motor, that drives a knife-
edge on a translation stage transversely across the laser
beam. The laptop has LabView control software to au-
tomate the scan, that can be accessed from the desktop.

Figure 1.2: NI MyDAQ data acquisition card to record
photodiode voltage and New Focus Pico Motor Con-
troller connected via ethernet cable/USB adapter to lap-
top.

The New Focus pico motor can be incremented in
precise 30 nm steps. To minimize the time required for
a scan, the laser beam is focused to a tight laser waist,
just after which the knife-edge is scanned, as in Fig. 1.3

Figure 1.3: Knife-edge between focusing lenses, with
the photodiode illuminated by a HeNe laser.

1.4 Measurements

1.4.1 Knife-edge Scans

After familiarizing yourself with the equipment, turn on
the laser and observe the beam shape using the white-
screen as in Fig 1.4 to image the laser beam spot at vari-

ous locations through the setup, noting the focal lengths
of the lenses used. The light should pass through all
lens apertures to avoid clipping of the beam profile.

When the knife-edge is positioned half-way through
the laser-beam, the pattern on the card appears as in
Fig 1.4. You may notice there is a distortion of the ge-
ometric shadow on the card as the knife-edge passes
through the laser-beam - why is this? Is this effect ex-
pected at a particle accelerator? Under what circum-
stances does this effect not matter for this experiment?

Figure 1.4: Beam imaged on white screen, without and
with knife-edge in beam

The active area of the photodiode is small, therefore
the light transmitted beyond the knife-edge must be re-
focused to be collected entirely by the photodiode, as
in Fig 1.5.

Figure 1.5: Laser spot focused onto photodiode



Figure 1.6: LabView software to control the stage and
read out the photodiode during a scan of the knife-edge.

Performing a scan:

• Open the LabView software in Fig. 1.6 and use
it to record a scan, by running the program, then
pressing the start and stop buttons. Select COM3
when prompted.

• The voltage signal at each sampling point is
recorded to a timestamped data file in the
C:/CAS2017/ folder.

• Check that the scan records the full beam profile
as an error function; you may wish to adjust the
step size and sampling time for a more rapid scan,
within the limits of the driver.

1.4.2 Beam profile extraction

The recorded data file may be analyzed by the
CAS readata.vi LabView software shown in Fig. 1.7.
The raw data are filtered by averaging over a certain
number of samples, then the signal is differentiated to
obtain a plot of the beam profile versus knife-edge po-
sition.

Figure 1.7: Analysis software to read the photodiode
data, filter for noise and differentiate to obtain the pro-
file.

1.4.3 Gaussian beam profile

Fit a Gaussian (or otherwise) to the beam profile to ex-
tract the width. Compare this with the width of the

Gaussian waist you would expect at the focus of the
lenses. How would you improve / calibrate the setup?

If there is sufficient time, replace the knife-edge with
the adjustable slit and repeat the scan. Can you opti-
mize the slit size to obtain the best beam profile?

1.4.4 Beam Halo measuring a single-slit diffrac-
tion pattern

When the first lens in the setup is replaced with an ad-
justable single slit, a diffraction pattern is produced in
the far field with the intensity: I(x) = sin2(x)

x2 , as in
Fig. 1.8. Thus the distribution has a central “core” and
an interesting side patterns that can be considered as the
“beam halo”.

Figure 1.8: Single slit diffraction pattern.

Use the apparatus to obtain beam profiles showing
clear features of the core and halo. Consider whether
the photodiode will saturate when exposed to the full
laser beam. Place different optical filters (ND > 2.0)
in front of the photodiode, as in Fig 1.9 to obtain pro-
files with the necessary dynamic range. How could the
setup be modified to obtain both sides of the halo dis-
tribution?

Figure 1.9: Filter inserted in front of photodiode.
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Lab 2: Beam Emittance by the Three Screen Method

2.1 Aims and Objectives

The experimental aim is to measure the emittance of a
laser beam. The main objectives are to:

• understand the theory of emittance measurement
by the three screen method.

• calibrate a CCD camera and use it to record mul-
tiple beam profiles of a laser beam.

• calculate the beam widths using a Gaussian fit to
the recorded profiles.

• apply the three-screen method matrix formalism
to determine the horizontal emittance of the laser
beam.

2.2 Emittance Measurement Theory

If β is known unambiguously as in a circular machine,
then a single profile measurement determines ϵ by

σ2
y = ϵβy.

But it is not easy to be sure in a transfer line which β
to use, or rather, whether the beam that has been mea-
sured is matched to the β-values used for the line. This
problem can be resolved by using three monitors (see
Fig. 2.1), i.e. the three width measurement determines
the three unknown α, β and ϵ of the incoming beam.

Figure 2.1: Overview of three screen profile measure-
ment technique for emittance measurement.

Introducing the σ-matrix (see for example, K. Wille;
Physik der Teilchenbeschleuniger, Teubner):

σ =

(
σ11 σ12

σ21 σ22

)
=

(
σ 2
y σyy′

σy′y σ 2
y′

)
= ϵ

(
β −α
−α γ

)

where βγ−α2 = 1, then the rms emittance is given by

ϵrms =
√
detσ =

√
σ11σ22 − σ 2

12

The rms beam width of the measured profile is

σy =
√
σ11 =

√
β(s) · ϵ .

Transformation of σ-matrix through the elements of
an accelerator:

σs1 = M · σs0 ·MT

where M =

(
M11 M12

M21 M22

)
, MT =

(
M11 M21

M12 M22

)
.

L1, L2 = distances between screens or from
Quadrupole to screen and Quadrupole field strength are
given, therefore the transport matrix M is known.

Applying the transport matrix gives (now time for
exercise):

σs1 = M · σs0 · MT

=

(
M11 M12

M21 M22

)
·
(
σ11 σ12

σ21 σ22

)
·
(
M11 M21

M12 M22

)

= σ
meas

=

(
σ 2
y σyy′

σy′y σ 2
y′

)meas

s1

= ϵ

(
β −α
−α γ

)

=

(
M11 M12

M21 M22

)
·
(
σ11M11 + σ12M12 σ11M21 + σ12M22

σ21M11 + σ22M12 σ12M21 + σ22M22

)
=

(
M11(σ11M11 + σ12M12) + M12(σ21M11 + σ22M12) ...

... ...

)

therefore

σ(s1)
meas
11 = σ2(s1)

meas
y

= M 2
11σ(s0)11 + 2M11M12σ(s0)12 +M 2

12σ(s0)22

where σ12 = σ21). Solving σ(s0)11, σ(s0)12 and
σ(s0)22 while the matrix elements are known needs
minimum of three different measurements, either
three screens or three different quadrupole settings
with different field strength.

ϵrms =
√
detσ =

√
σ11σ22 − σ 2

12

2.3 Experimental Setup

2.3.1 Overview

By moving the lens one can take pictures from the cam-
era in the focus (not preferred due to limited resolu-
tion of the optic system) and on other positions. The
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distance of the lens to various screen positions can be
measured by a simple ruler1. The camera is connected
to a Computer where the readout software is installed.
The pictures (.jpg) can be saved and can be loaded into
a free software called “ImageJ” where a profile of an
area can be displayed and the curser position and the
value is displayed (8 bit). The σ of the profile have
to be found for each screen (camera) position and the
emittance have to be calculated.

Figure 2.2: Experimental setup for three screen emit-
tance measurement

2.3.2 Hardware parameters

Parameters for the hardware are provided below and in
Fig. 2.3.

CCD Phytec USB-CAM 051H

screen material: white paper

grid target spacing 1mm

laser Z-Lasers

1Move the lens to simulate different screen positions

Figure 2.3: Parameters for CCD and laser

2.4 Measurements

2.4.1 CCD control

Start by becoming familiar with how to acquire data
from the CCD, which is readout by the program
PHYTEC Vision Demo 2.2, as in Fig. 2.4.

Figure 2.4: CCD control and readout.

2.4.2 Data analysis with ImageJ

After acquiring a CCD image, use the software ImageJ
to select a region of interest and plot the horizontal pro-
jection, as in Fig 2.5. Save the data in Excel format for
profile fitting.



Figure 2.5: Selection of beam profile data for fitting.

Load the recorded profile data and fit a Gaussian as
in Fig. 2.6.

Figure 2.6: Gaussian fit to profile data.

2.4.3 Calibration

Square grid paper can be used to calibrate the distance
to pixel size of the camera, as in Fig. 2.7.

Figure 2.7: Calibration of readout setup using a mm-
grid

2.5 Calculation of emittance

Take profiles at three different distances between the
lens-screen, using the formula from the theory section
and below to calculate to the emittance.

• Hint 1: Make the distances equal, set s1 = 0, s2 =
−s0

• Hint 2: Avoid position at waist (why?)

Figure 2.8: Three profiles

Recall from above that:

σ 2
y,meas = M 2

11σ(s0)11+2M11M12σ(s0)12+M 2
12σ(s0)22

The drift matrix for no optical elements is simply

M =

(
1 s
0 1

)



Note that:

σ2(s1)meas = σ11 + 2s1σ12 + s 2
1 σ22

σ2(s0)meas = σ11 + 2s0σ12 + s 2
0 σ22

σ2(s2)meas = σ11 + 2s2σ12 + s 2
2 σ22

with

σ11 = σ 2
y (0)

σ12 =
σ 2
y (+s)− σ 2

y (−s)

4s

σ22 =
σ2
y(+s)− 2 · σ2(0) + σ 2

y (−s)

2 · s2

σ =

(
σ11 σ12

σ21 σ22

)
=

(
σ 2
y σyy′

σy′y σ 2
y′

)
= ϵ

(
β −α
−α γ

)

ϵrms =
√
detσ =

√
σ11σ22 − σ 2

12

For reference, some preliminary measurements of
the beam sigma versus lens distance is given in Fig. 2.9.

Figure 2.9: Preliminary test measurements of laser
beam in this setup.
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Lab 3: Pepperpot Emittance Measurement

3.1 Aims and Objectives

These hands on exercises aim to introduce emittance
measurements by the pepperpot technique. An optical
bench with a light source, a pepperpot plate, several
lenses and a GigaBit Ethernet camera is provided.

3.2 Experimental Setup

3.2.1 The Optical Bench

The optical bench shown in Fig. 3.1 consists of the fol-
lowing parts:

• a particle source (powerful red LED)

• a collimator producing a point like source

• the lenses with the following focal length: 24, 30,
43, 54, 76 and 100 mm.

• a pepperpot plate with 9x9 holes (200 µm) of 2
mm distance

• a screen

• a Prosilica-GC750 GigaBit Ethernet camera

Figure 3.1: Optical bench pepperpot setup.

3.2.2 Software

The following software is part of the system:

GigEViewer This program as well as a LabView
equivalent is delivered by the supplier of the cam-
era. It allows modifying the settings of the cam-
era (exposure time, gain ...) and can display the

camera image in real-time. Snapshots can also be
taken. The program allows saving the camera im-
age in Microsoft tif (.tif) format, the LabView pro-
gram also permits .png, which is the preferred for-
mat.

OpticalRayTrace is a simulation program for optical
benches. This program is used to understand the
optical properties of the pepperpot bench.

QPepperpot is a program that allows evaluation of the
bitmap file. You can:

• load an image

• find x and y coordinates of a point within the
image

• find and plot a single row or column to find
the pixel intensities

• define an area of interest (AOI)

• calculate and plot projections to the x or y
axis

• save the image in ASCII format for evalua-
tion with standard tools like excel, MatLab
etc.

• save the projections (in ASCII)

• enter the center position of the image

• enter the scaling factor (number of pixels /
mm)

• calculate and plot the emittance mountain

• save the emittance data (in ASCII) for fur-
ther evaluation or plotting with an external
program

3.3 Calculation of the Optics

Measure the distances between the light source, the
lenses and the screen and simulate the optical properties
of your line with OpticalRayTracer 1 , as in Fig. ref-
fig:PepperPotRayTrace. The physics background used
by this program can be found in the document ’Opti-
calRayTracer Technical Discussion’ of which you have
a printed copy. Details on how to use the program you
find in its help file.

1http://arachnoid.com/OpticalRayTracer/
index.html
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Figure 3.2: Optical ray trace of the lenses in the setup.

3.4 Emittance Measurements from a Pep-
perpot Image

3.4.1 Calibration

Before starting to take any measurements the device
needs to be calibrated. We need to know the relation-
ship between the distance of 2 points on an image in
pixels and this same distance in reality, in mm. In order
to do this calibration the screen is replaced by the pep-
perpot plate and an image is taken. The center of the
image in pixels must also be determined.

Figure 3.3: The pepperpot plate.

The pepperpot evaluation program brings up a cursor
if you press the first mouse button on the pepperpot im-
age and the current cursor position is shown on the LCD
display (bottom left in Figure 3). The screen is then put
back and the distance between camera and screen stays
fixed from then on.

3.4.2 Evaluating a ’good’ measurement

The image in Fig. 3.4 shows a typical “good” measure-
ment. The image of each pepperpot hole is clearly vis-
ible, the signal to noise ration is good.

In order to extract the emittance from this image first
start the pepperpot evaluation program QPepperpot and
read in an image from a measurement file (File → Open
image). The image file must be a valid pixmap file e.g.
“screenimage.bmp”. Then enter the calibration values,

Figure 3.4: OPepperpot evaluation program.

scaling factor in pixels/mm (32.6 in Fig. 3.5) and the
center of the pepperpot plate in pixels (320,240).. Only
the horizontal value will be used. The settings dialog
box (Settings → Configure Pepperpot) is foreseen for
this purpose.

Figure 3.5: OPepperpot settings diaglog box.

The next step is to calculate the projection of the im-
age to the horizontal axis (Tools → Projections or the
Toolbar button showing the histogram)

The Tools menu in the menu bar allows selection of
options for display of the projection. You may

• Display only the raw data. Display of raw data
may be switched of if low-pass filtering is enabled.

• Low-pass filter the data and show the filtered data

• Automatically find the 8 peaks in the histogram
that correspond to the image of the 8 pepperpot
holes.

• Switch display of the peak positions on or off.



Figure 3.6: Projection of pepperpot image.

In Fig. 3.6 all curves are shown on a single plot:
The blue curve shows the raw data. On the red curve
the projection is filtered and the black curve shows the
peaks found. The mean noise value and its variance,
calculated over the first 50 points is also displayed. You
may also read the peak positions by pushing the first
mouse button

Now that the positions of the image of all 8 pepper-
pot holes is known and the calibration has been entered
the emittance ellipse can be determined. Tools → Emit-
tance will display the results. Fig. 3.7 shows a typical
emittance plot for a converging beam.

Figure 3.7: Emittance plot derived from pepperpot im-
age.

3.4.3 Evaluating a measurement that is less clean

Unfortunately not all measurements are as clean as the
one shown in the previous section. If the camera set-
tings as not perfect e.g. the aperture is not opened
enough, if the contrast settings are not perfect . . . we
may end up trying to analyse an image who’s projec-

tion looks like the one shown in Fig. 3.8. Since even a
human has a hard time to see the hole images, it is even
more difficult for a program to automatically evaluate
such an image.

Figure 3.8: Projection of a pepperpot image with excess
noise.

The pepperpot evaluation programs help through low
pass filtering and offset suppression (Tools → Show fil-
tered and Tools → Subtract Offset).

Figure 3.9: Projection of a pepperpot image cleaned of
noise.

If you try to automatically find the peaks however,
the program will only find four out of the eight peaks.
These peaks can be copied to the settings dialog box
with the copy to manual peaks button. After having
copied the peaks, switch off automatic peak finding
(Tool → Automatically find peaks must be switched
off). You may now define the peaks by hand in the
settings dialog box. The plot will show you how you
placed them. All 8 peaks must be defined. Clicking
the left mouse button on the projection plot brings up
a cursor whose current position is shown. This may
help you when finding the peaks. You may also have
a closer look at the background in order to see if the
are any systematic errors by switching on the zooming.



Click and drag to zoom into the picture. Once you fin-
ished defining the peaks by hand you may again try to
plot the emittance. The emittance plot will use the man-
ually defined peaks instead of the automatically found
ones.
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Lab 4: Imaging Techniques

4.1 Aims and Objectives

This Laboratory exercises introduces to the basic prop-
erties of imaging techniques which are widely used in
accelerator for transverse profile measurements. The
main subjects covered in this lab are:

• To become familiar with the imaging using camera
lenses and lenses

• To perform low and high magnification optical
system

• To observe field depth limitation and try compen-
sating scheme based on the Scheimpflug principle

• To become familiar with the principle of pinhole
cameras and design/test pinhole cameras with ei-
ther low or high optical magnification

4.2 The Basics of Optical System Design

Imaging with lenses is the simplest and most common
practice in beam imaging system. A schematic of such
a system is presented in Figure 4.1. A definition of
the optical magnification and the relationship between
the focal length of the lens and the distances between
the image and object planes and the lens are also men-
tioned.

Figure 4.1: Imaging using a single lens.

4.3 Scheimpflug Principle

Normally, the lens and image (film or sensor) planes
of a camera are parallel, and the plane of focus (PoF) is

parallel to the lens and image planes. If a planar subject
(such as the side of a building) is also parallel to the
image plane, it can coincide with the PoF, and the entire
subject can be rendered sharply. If the subject plane is
not parallel to the image plane, it will be in focus only
along a line where it intersects the PoF, as illustrated in
Figure 4.2.

Figure 4.2: Depth of Field limitation when imaging an
object tilted with respect to the lens/camera planes cav-
ities.

But when a lens is tilted with respect to the im-
age plane, an oblique tangent extended from the image
plane and another extended from the lens plane meet at
a line through which the PoF also passes, as illustrated
in Figure 4.3. With this condition, a planar subject that
is not parallel to the image plane can be completely in
focus.

4.4 Pinhole Camera

A pinhole camera is a imaging system without a lens
but with a tiny aperture, a pinhole – effectively a light-
proof box with a small hole in one side. Light from a
scene, as depicted in 4.4. passes through the aperture
and projects an inverted image on the opposite side of
the box, which is known as the camera obscura effect.
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Figure 4.3: The Scheimpflug principle.

Figure 4.4: The principle of a pinhole camera.

4.5 Measurements

4.5.1 Imaging with camera lenses

Build an optical imaging system using camera lenses
with a magnification of 0.1 and 1

4.5.2 Imaging with lenses

Build an optical imaging system using lenses with a
magnification of 0.1 and 1

4.5.3 Imaging a tilted object

For a high magnification optical system (1 or more), tilt
the lens by 45degree or more and using the Scheimpflug
principle obtain an image with minimum blurring

4.5.4 Imaging using a pinhole

Build an pinhole camera with a magnification of 0.1
and 1 with the minimum exposure time and best possi-
ble image quality.

What are the best parameters of the best configura-
tions you found ?

The best picture wins a beer !
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Lab 5: Electro-Optic Modulator

5.1 Aims and Objectives

This experiment aims to demonstrate the potential in
using of electro-optic modulators in beam instrumen-
tation. EO crystals have a time response that expands
from DC to tens of GHz which clearly surpass the typi-
cal bandwidth of electromagnetic monitors. It can thus
be used for the detection and/or the transmission of
electric beam signal over an very large bandwidth. The
main objectives are:

• Apply a DC voltage pulse across an electro-optic
modulator (EOM).

• Observe the modulation of light passing through
the EOM recorded by a photodiode

• Measure electric to optical to electric conversion
ratio

• Measure the dynamic range of the system

• Apply fixed frequency RF signals and measure the
bandwidth of the setup.

• Observe the effect of modifying the EOM bias on
the RF signal.

5.2 Electro-Optic Modulator

Electro-Optic Modulators (EOMs) are commonly used
in telecommunications for rapidly modulating optical
intensity to transmits high bandwidth signals over opti-
cal fibre. An EOM relies on the electro-optic Pockels
effect in a lithium niobate crystal, which modifies the
polarization state of the light, when a transverse elec-
tric field is applied.

5.3 Experimental setup

Warning: the laser enclosed in this experiment is a
class IV laser. DO NOT OPEN THE SAFETY
BOX. Avoid eye exposure to laser radiation.

The present system is an optical fibre based system.
It uses a DC fiber laser connected to a commercial
electro-optical modulator. The RFin voltage signals,
provided by a pulsed generator, are encoded onto the
laser beam and measured by a fast photodiode, which
provides an output signal denominated RFout. The lat-
ter is finally acquired by an oscilloscope. The EO mod-
ulator crystal can also be biased by an external DC volt-
age to tune and keep the system performance optimal.

Figure 5.1: Electro-Optic modulator test bench.

Figure 5.2: Connection diagram for the electro-Optic
modulator test bench.
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5.4 Measurements

5.4.1 Detecting Fast Pulses

• Apply a DC pulse (on RFin) across the pickup, can
you see it on the scope?

• Set the oscilloscope to measure both the input
RFin and output RFout voltages simultaneously.

• Plot the evolution of the signal RFout as a func-
tion of the amplitude of the RFin DC signal. What
shape does it have ? What is the electric-to-
optical-to-electric conversion ratio of the present
system in dB ? What is the dynamic range of the
system ? DO you observe over rotation ?

• Apply now shorter or shorter pulse (RFin) across
the pickup, can you see it on the scope? What is
the minimum pulse length you can reproduce and
measure efficiently ? What will be the correspond-
ing bandwidth of the system

5.4.2 Bias scans

• Turn on the bias voltage

• Scan the bias voltage by small step (i.e. 0.1volts)
and plot the amplitude of the RFout signal as a
function of the bias voltage. Find the best DC bias
voltage that would provide the highest output volt-
age RFout.

• For a pulse length of your choice, increase the am-
plitude of the RFin signal and adjust the dc bias to
keep the output voltage Rfout constant. Plot then
the curve RFin as function of DC bias for a con-
stant output signal RFout. What do you conclude
?

• Change the pulse length of RFin and redo the bias
voltage scan. Do you find the same optimum as
before ?
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